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Informations relatives au règlement en matière de communications 
et de sécurité

La déclaration de conformité Edit Pack est conforme aux 
normes suivantes en matière d’interférences et de 
compatibilité électromagnétique :
• FCC Partie 15 Classe A
• EN55103 - 1, environnement E4
• EN55103 - 2, environnement E4
• AS/NZS 3548 Classe A
• CISPR 22 Classe A
• ICES-003 Classe A

Déclaration de conformité pour le Canada

Cet appareil numérique de la classe A est conforme à la norme 
ICES-003 du Canada.

Cet appareil numérique de la classe A est conforme à la norme 
NMB-003 du Canada.

Déclaration de conformité européenne 

Digidesign est autorisé à appliquer la mention CE (Conformité 
Européenne) sur l’équipement conforme, déclarant ainsi la 
conformité à la directive EMC 89/336/EEC et à la directive de 
basse tension 73/23/EEC.

Conformité pour l’Australie 

Déclaration FCC 
Cet équipement a été testé et déclaré conforme aux
limites pour un appareil numérique de la classe A, 
conformément à la partie 15 du règlement FCC.

Déclaration de communications
Cet équipement a été testé pour être en conformité avec les 
limites pour un appareil numérique de la classe A. Les 
changements ou modifications apportés à ce produit
et non autorisés par Digidesign, Inc., peuvent annuler la 
certification et supprimer votre habilité à faire fonctionner le 
produit.

Ce produit a été testé par rapport à sa conformité CISPR dans 
les conditions incluant l’utilisation de périphériques et de 
câbles et connecteurs blindés entre les composants du 
système.

Digidesign recommande l’utilisation de câbles et connecteurs 
blindés entre les composants du système pour réduire la 
possibilité d’interférences sur les radios, téléviseurs et autres 
appareils électroniques.

Déclaration de sécurité 
Cet équipement a été testé pour être en conformité avec la 
certification de sécurité des Etats-Unis et du Canada et 
conformément aux spécifications des normes UL (UL1419) et 
des normes canadiennes CSA (CSA C22.2 n˚ 1 – M90 et 
IEC950).



  
Consignes de sécurité importantes

Lors de l'utilisation d'équipement électrique ou électronique, 
veuillez observer les précautions de base suivantes :
• Lisez toutes les instructions avant d’utiliser cet 

équipement.
• Pour éviter tout risque de décharge électrique, tenez cet 

équipement éloigné de la pluie et autres sources 
d’humidité. N'utilisez pas cet équipement s’il est mouillé.

• L’équipement doit être connecté uniquement à la tension 
électrique correspondant à celle indiquée sur le produit.

• N’essayez pas de réparer l’équipement. Il ne contient 
aucun composant pouvant être réparé par l’utilisateur. 
Pour toute réparation, adressez-vous au personnel 
Digidesign autorisé.

• Toute tentative visant à réparer l’équipement vous expose 
à un risque de décharge électrique, et annule la garantie 
du fabricant.

• Le produit doit être connecté uniquement à la tension 
électrique correspondant à celle indiquée sur le produit.

• N’installez pas l’unité à proximité de sources de chaleur, 
telles que des radiateurs, poêles ou autres appareils 
(amplificateurs compris) produisant de la chaleur.

• Veillez à ne pas marcher sur le cordon d’alimentation, ni à 
le pincer, en particulier au niveau des prises, des fiches 
femelles et de leur point de connexion à l’appareil.

• Installez l’unité près de la prise de courant pour pouvoir 
débrancher facilement l’appareil.

• Pour le nettoyage, utilisez uniquement un chiffon humide.
• Débranchez l’appareil en cas d’orage ou s’il n’est pas 

utilisé pendant une longue période.
• Ne retirez pas la sécurité de la prise polarisée. Une prise 

polarisée possède deux lames, dont l’une est plus large 
que l’autre, pour assurer votre sécurité. Si la prise fournie 
n’est pas adaptée à votre fiche, consultez un électricien, 
afin qu’il remplace la prise obsolète.

N’OBSTRUEZ PAS LES CONDUITS DE VENTILATION.
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chapitre 1

Introduction

Edit Pack™ est une surface de contrôle destinée 
aux systèmes Pro Tools. 

Edit Pack comprend de nombreuses fonctions 
de mixage et de panoramisation permettant 
d’optimiser le mixage multicanal pour le son 
surround. La surface offre également un accès 
direct aux commandes et fonctions Pro Tools les 
plus utilisées. 

Composition
Le coffret Edit Pack comprend :

• surface de contrôle Edit Pack

• guide d’Edit Pack

• câble d’alimentation

• câble Ethernet

• câble USB

• connecteur de bouclage Ethernet (pour les 
tests)

• carte d’enregistrement

Fonctions
Les principales caractéristiques d’Edit Pack sont 
les suivantes :

Sections de panoramisation

◆ deux joysticks DigiPanners™ de 
panoramisation tactiles motorisés 

◆ deux sections complètes de panoramisation, 
avec chacune un joystick DigiPanner et un 
ensemble de commandes de panoramisation 

◆ des commandes de navigation pour la 
sélection et l’affectation de pistes dans Edit Pack 

VU-mètres

◆ huit VU-mètres à 40 segments offrant une 
visualisation des niveaux de sorties multicanaux 
haute résolution

Clavier et trackball

◆ clavier QWERTY avec touches personnalisées 
et colorées, trackball de 38,1 mm

Touches

◆ 20 touches d'édition à double fonction

◆ touches supplémentaires dédiées à de 
nombreuses fonctions spécifiques, telles que 
Machine Control, la liste des événements MIDI, 
la hauteur de piste, la liaison des sélections 
d’édition et de timeline
Chapitre 1 : Introduction 1
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Affichage

◆ afficheurs numériques de grande taille à huit 
caractères pour le début, la fin et la durée 
d’édition et de timeline

Configuration requise

Pour utiliser Edit Pack, vous avez besoin du 
matériel suivant :

■ système Pro Tools équipé de la surface de 
contrôle ProControl et de Pro Tools version 5.1 
ou ultérieure

■ un hub Ethernet disposant d’un port libre 
pour Edit Pack

■ le fichier de personnalité du contrôleur 
Edit Pack (inclus dans Pro Tools) doit être 
installé dans le dossier Controllers, à l'intérieur 
du dossier DAE. (Consultez le Chapitre 2, 
Installation d’Edit Pack, pour plus 
d'informations.)

Informations sur la compatibilité

Digidesign peut assurer la compatibilité et 
fournir une assistance uniquement pour le 
matériel et les logiciels testés et agréés par ses 
soins. Pour obtenir la liste des ordinateurs, 
systèmes d'exploitation et périphériques tiers 
agréée par Digidesign, consultez les dernières 
informations de compatibilité sur le site Web de 
Digidesign :

www.digidesign.com/compato/

Enregistrement Digidesign

N'oubliez pas de remplir et de retourner la carte 
d’enregistrement fournie avec Edit Pack. 

A propos de ce guide
Ce guide part du principe que vous avez déjà 
installé Pro Tools et ProControl et assimilé leurs 
fonctions et conventions de fonctionnement. 
Pour plus d’informations, consultez le Guide de 
référence Pro Tools et le Guide de ProControl. 

Edit Pack requiert une unité principale 
ProControl.

Le Guide d’Edit Pack n’explique pas le 
fonctionnement de Pro Tools ni de 
ProControl. Avant de commencer à 
travailler avec Edit Pack, vous devez 
maîtriser la terminologie, les concepts et le 
fonctionnement de base de votre système 
Pro Tools équipé d’une surface de contrôle 
ProControl. Pour plus d’informations, 
consultez le Guide de référence Pro Tools et 
le Guide de ProControl.
Guide d’Edit Pack



                 
Conventions utilisées dans ce 
guide

Ce guide utilise les conventions suivantes pour 
indiquer les choix de menu et les commandes 
principales de Pro Tools :

Les symboles qui suivent permettent de mettre 
en évidence des informations importantes :

Combinaisons Edit Pack et ProControl 

Dans ce guide, toutes les références renvoient 
aux touches Edit Pack, sauf mention contraire 
(certaines opérations nécessitent l’utilisation 
d’une ou plusieurs touches ProControl). Pour les 
opérations nécessitant des touches de 
modification, vous pouvez utiliser :

• les touches de modification du clavier 
Edit Pack (Shift, Cmd, Opt/Alt, Ctrl/Ctrl) 

• les touches de modification du clavier d’un 
ordinateur distinct, le cas échéant

• les touches de modification de ProControl 
(touches de la section Raccourcis) :

Convention Action

File > Save Session Choisissez Save Session 
dans le menu File

Ctrl + N Tout en maintenant la 
touche Ctrl enfoncée, 
appuyez sur la touche N

Option-clic Tout en appuyant sur la 
touche Option, cliquez à 
l’aide du bouton gauche 
de la souris

Clic à droite (Windows) Cliquez à l’aide du 
bouton droit de la souris

Les conseils aux utilisateurs sont des astuces 
qui vous permettent de tirer le meilleur parti 
d’Edit Pack.

Les avertissements importants contiennent 
des informations susceptibles de modifier 
les données d'une session Pro Tools, ainsi 
que les performances de Pro Tools ou 
d’Edit Pack.

Les raccourcis clavier permettent d’accéder 
rapidement à diverses tâches.

Les références croisées vous dirigent vers des 
sections associées des guides d’Edit Pack, de 
Pro Tools ou de ProControl.

touche de modification 
(Macintosh/Windows)

RACCOURCI ProControl

Maj SHIFT/ADD

Option (Macintosh)
Alt (Windows)

OPT(ALT)ALL

Commande (a 
Macintosh)
Ctrl (Windows)

a(CTL)

Ctrl (Macintosh)
Démarrer (Windows)

CTL/CLUTCH
Chapitre 1 : Introduction 3
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chapitre 2

Installation d’Edit Pack

Ce chapitre traite des instructions d’installation 
matérielle et logicielle pour Edit Pack. 

La rubrique Démarrage rapide s’adresse aux 
personnes déjà familiarisées avec les systèmes 
ProControl étendus.

Démarrage rapide

Matériel :

◆ Placez Edit Pack aussi près que possible de 
votre position d'écoute optimale. Pour plus 
d'informations, reportez-vous à Instructions 
d'installation et de maintenance, page 5.

◆ Connectez les ports d’alimentation, Ethernet 
et USB ou ADB (si vous avez l’intention d’utiliser 
le clavier et le trackball) à la surface de mixage 
Edit Pack. Pour plus d'informations, reportez-
vous à Panneau arrière d’Edit Pack, page 6.

Logiciels :

◆ Assurez-vous que la version 5.1 (ou ultérieure) 
de Pro Tools est installée et fonctionne 
correctement et que le fichier de personnalité 
d’Edit Pack se trouve bien dans le dossier 
Controllers, à l’intérieur du dossier DAE (pour 
en savoir plus, reportez-vous à Instructions 
d'installation et de maintenance, page 5). 

Démarrage et connexion

◆ Mettez votre système sous tension dans 
l’ordre approprié (voir Démarrage et fermeture 
d'un système, page 8). Lancez ensuite Pro Tools 
et configurez-le pour une utilisation avec 
Edit Pack (pour en savoir plus, reportez-vous à 
Configuration de Pro Tools pour Edit Pack, 
page 8).

Instructions d'installation et 
de maintenance
Lorsque vous placez Edit Pack dans votre studio 
(dans un meuble ou sur une table), assurez-vous 
de suivre les recommandations ci-dessous.

• N’obstruez pas les grilles d’aération avant et 
arrière.

• Ne retirez pas les pieds de la surface de 
mixage.

• Veillez à ne pas brancher ni débrancher les 
câbles du clavier et du trackball (USB ou ADB) 
lorsque l’unité centrale est sous tension. 

• Nettoyez et entretenez Edit Pack de la même 
façon que ProControl (reportez-vous au 
Guide ProControl pour en savoir plus).
Chapitre 2 : Installation d’Edit Pack 5
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Choix d’un emplacement

Vous devez pouvoir accéder facilement à 
Edit Pack depuis la position d’écoute optimale 
de votre environnement de mixage. Si votre 
système ProControl est volumineux, placez 
Edit Pack à proximité de votre unité principale, 
avec les packs de faders de chaque côté (mais de 
préférence pas entre les unités principale et 
d’Edit Pack). En raison de la nature du mixage 
multicanal en mode surround (la fonction pour 
laquelle Edit Pack a été conçu), l’équilibrage de 
l’écoute est essentiel. 

Assemblage d’un système étendu

Vous pouvez connecter Edit Pack à d’autres 
unités ProControl et packs de faders à l’aide des 
fixations avant et arrière fournies dans le coffret. 
Pour en savoir plus, reportez-vous au Guide 
ProControl. 

Panneau arrière d’Edit Pack
Le panneau arrière comprend les ports suivants :

Port ADB pour la connexion du clavier et du 
trackball d’Edit Pack à un ordinateur doté d’un 
port ADB.

Port USB pour la connexion du clavier et du 
trackball d’Edit Pack à un ordinateur doté d’un 
port USB.

PS-2 Non utilisé (ports pour souris et clavier)

MAC/PC Sélecteur pour clavier et trackball

Ethernet Chaque unité Edit Pack comprend un 
port Ethernet. 

Port COM et DEL Ethernet Le port COM est 
destiné aux diagnostics d’usine uniquement. Les 
DEL d’activité et de liaison indiquent le statut et 
l’activité Ethernet pour le dépannage et les tests 
de communication. 

Alimentation Ce connecteur accepte un câble 
d'alimentation CA standard. Edit Pack, 
ProControl et les packs de faders s’adaptent 
automatiquement à la tension d’alimentation 
(de 100 à 240 Volts) : un câble modulaire 
standard permet de les connecter aux prises 
murales de tous les pays. 

Connexions matérielles
Edit Pack requiert trois types de connexions (les 
câbles nécessaires sont fournis) :

• Alimentation

• Ethernet Edit Pack communique avec 
Pro Tools au moyen d'un connecteur de type 
 10Base-T RJ45 standard (identique à celui de 
ProControl et des packs de faders).

• Connexions du clavier et du trackball (USB ou 
ADB)

Avant de connecter Edit Pack, assurez-vous que 
la surface de mixage et votre ordinateur sont 
hors tension. 

Vérifiez toujours que votre système n’est pas 
sous tension avant de connecter ou de 
déconnecter le câble du clavier et du 
trackball (USB ou ADB).
Guide d’Edit Pack



                             
Pour connecter Edit Pack à votre système :

1 Reliez Edit Pack à une source d’alimentation à 
l’aide du câble d’alimentation (fourni dans le 
coffret Edit Pack). Le connecteur d’alimentation 
accepte un câble d'alimentation CA standard et 
s'adapte automatiquement à la tension 
d'alimentation. 

2 Pour effectuer les connexions Ethernet, 
connectez l’une des extrémités du câble RJ45 
(fourni dans le coffret) au port d’un hub 
Ethernet. N’utilisez pas de port destiné à des 
fonctions de liaison montante. 

3 Connectez l’autre extrémité du câble RJ45 au 
port Ethernet situé sur le panneau arrière 
d’Edit Pack.

4 Assurez-vous que l’interrupteur MAC/PC est 
en position MAC. 

5 Connectez le câble du clavier et du trackball :

■ Pour les systèmes USB, connectez l’une des 
extrémités d’un câble USB compatible au port 
USB d’Edit Pack, puis connectez l’autre 
extrémité à un port USB disponible sur votre 
ordinateur (ou adaptateur de port série validé).

■ Pour les systèmes ADB, connectez le port ADB 
d’Edit Pack à un port série disponible sur votre 
ordinateur. 

Installation logicielle
Le programme d'installation de Pro Tools 
installe automatiquement l'ensemble des 
logiciels de la surface Edit Pack dans le cadre 
d'une installation facile. Un nouveau 
micrologiciel Edit Pack est fourni dans le fichier 
de personnalité d’Edit Pack à chaque mise à 
niveau de Pro Tools. 

Si vous n’avez pas encore installé (ou mis à jour) 
Pro Tools, interrompez l’installation logicielle et 
consultez dès maintenant le Guide d'installation 
TDM. Suivez les instructions de ce guide afin de 
procéder à l’installation facile de Pro Tools. 

Si vous avez effectué l’installation personnalisée 
de Pro Tools, vous devrez peut-être ajouter le 
fichier de personnalité d’Edit Pack à votre 
système Pro Tools déjà installé (version 5.1 ou 
ultérieure).

Pour installer le logiciel Edit Pack à partir de votre 
programme d’installation Pro Tools.

1 Insérez le disque d’installation de Pro Tools 
dans un lecteur de CD-ROM et lancez le 
programme. 

2 Choisissez l’option d’installation 
personnalisée (Custom Install).

3 Sélectionnez ensuite Edit Pack et cliquez sur 
Install.

Le programme d'installation place le fichier de 
personnalité d’Edit Pack dans le dossier 
Controllers, qui se situe dans le dossier DAE, à 
l'intérieur du dossier System. 

N’utilisez pas le câble fourni par Digidesign 
avec la surface ProControl (dont les deux 
extrémités rouges sont thermorétractables) ; 
il ne fonctionne pas avec les systèmes 
étendus.
Chapitre 2 : Installation d’Edit Pack 7
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Démarrage et fermeture d'un 
système
Pro Tools est composé de plusieurs éléments qui 
doivent être mis sous et hors tension 
séparément : disques durs externes, ProControl, 
packs de faders, Edit Pack et interfaces 
informatiques et audio. Pour que l’ensemble de 
ces périphériques fonctionnent correctement, il 
est important de démarrer et d’arrêter le système 
dans l’ordre suivant.

Ordre de démarrage du système Pro Tools :

1 Mettez les disques durs externes sous tension. 
Patientez de 10 à 15 secondes, jusqu’à ce qu’ils 
atteignent leur vitesse nominale. 

2 Mettez ProControl sous tension, puis les 
packs de faders et enfin Edit Pack. 

3 Si vous envisagez de travailler avec du 
matériel MIDI, mettez les interfaces et autres 
périphériques MIDI sous tension. 

4 Mettez les interfaces audio Pro Tools sous 
tension. 

5 Mettez l'ordinateur sous tension. 

6 Mettez sous tension le système d’écoute / les 
haut-parleurs.

Ordre de mise hors tension du système Pro Tools :

1 Mettez hors tension le système d’écoute / les 
haut-parleurs.

2 Mettez les interfaces audio Pro Tools hors 
tension.

3 Eteignez l'ordinateur.

4 Si vous utilisez du matériel MIDI, mettez les 
interfaces, contrôleurs et autres périphériques 
MIDI hors tension.

5 Mettez ProControl (le son de l’unité 
principale est coupé à la mise sous/hors 
tension), les packs de faders et Edit Pack hors 
tension.

6 Mettez hors tension les disques durs externes. 

Configuration de Pro Tools 
pour Edit Pack

Pour configurer Pro Tools pour Edit Pack :

1 Mettez votre système sous tension en suivant 
l’ordre décrit dans Démarrage et fermeture d'un 
système, page 8. 

2 Lancez Pro Tools. 

3 Sélectionnez Setups > Peripherals et cliquez 
sur l’onglet Ethernet Controllers. 

4 Cliquez sur Scan. 

5 Activez l’unité principale et les packs de 
faders (le cas échéant) en les sélectionnant dans 
les sélecteurs d’unités appropriés (reportez-vous 
au Guide de ProControl pour en savoir plus).

6 Pour initialiser Edit Pack, sélectionnez-le à 
partir du sélecteur d’Edit Pack situé en bas de la 
fenêtre des contrôleurs Ethernet. 

7 Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals. Si le micrologiciel 
Guide d’Edit Pack



        
Edit Pack doit être mis à jour, Pro Tools vous 
demande si vous voulez procéder à une mise à 
jour. 

Micrologiciel Edit Pack 

Chaque nouvelle version de Pro Tools inclut le 
micrologiciel Edit Pack (et ProControl) le plus 
récent. Après avoir activé Edit Pack dans la boîte 
de dialogue Peripherals, Pro Tools compare le 
micrologiciel de toutes les unités connectées à la 
version disponible dans le logiciel Pro Tools. 
S’ils sont différents, Pro Tools vous invite à 
télécharger le nouveau micrologiciel pour 
mettre vos unités à jour. 

Test du système

Pour tester la communication de base :

1 Assurez-vous d’avoir installé et configuré 
Edit Pack conformément aux instructions des 
sections précédentes de ce chapitre. 

2 Ouvrez la session de démonstration de 
Pro Tools.

3 Sur la surface Edit Pack, appuyez sur la barre 
d’espacement. La lecture commence. 

Dans le cas contraire, vérifiez les connexions du 
clavier et du trackball (USB ou ADB) et essayez à 
nouveau. 

Pour tester les sections de panoramisation :

1 Dans la section de panoramisation gauche, 
appuyez sur TRACK SEL. 

2 Tournez le bouton SEL/ADJUST pour faire 
défiler la liste des pistes disponibles jusqu’à ce 
qu’une piste mono affectée à une sortie 
multicanal apparaisse dans l’affichage Channel 
Name. 

3 Appuyez de nouveau sur TRACK SEL pour 
régler Edit Pack sur la sortie de piste 
sélectionnée.

La sortie principale de la piste que vous venez de 
sélectionner est maintenant la cible de la section 
de panoramisation gauche. A l’écran, la sortie en 
cours est entourée d’orange (ou d’orange et de 
violet s’il s’agit d’un canal stéréo) dans 
l’affichage E/S de la fenêtre Mix). 

4 Commencez la lecture et la panoramisation 
avec Edit Pack. 

Cible d’Edit Pack

Lorsqu’une sortie ou un départ sont activés par 
une section de panoramisation d’Edit Pack, ils 
sont qualifiés de cible du contrôleur. 

Initialisation d’Edit Pack dans la fenêtre Peripherals > 
Ethernet Controllers.

Sections de panoramisation et commandes de 
sélection de pistes

TRACK SEL

SEL/ADJUST

Section de 
panoramisation 1

Section de 
panoramisation 2
Chapitre 2 : Installation d’Edit Pack 9
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Lorsque deux pistes stéréo sont sélectionnées, 
leurs deux canaux deviennent la cible des deux 
sections de panoramisation. Vous pouvez 
également faire correspondre les sections de 
panoramisation à un départ ou une piste mono 
distincts. 

Pour activer les deux sections de panoramisation 
indépendamment :

1 Activez la section de panoramisation 1 pour 
une piste mono, en suivant les instructions 
mentionnées plus haut. 

2 Appuyez sur TRACK SEL dans la section de 
panoramisation 2.

3 Sélectionnez une piste pour la section de 
panoramisation 2 en appuyant sur la touche de 
sélection de canal appropriée sur la surface 
ProControl. Il s’agit d’une autre manière 
d’activer une section de panoramisation pour 
une piste.

4 Commencez la lecture et la panoramisation 
avec Edit Pack. 

Cet exemple n’illustre que l’une des 
méthodes de sélection de pistes, de départs et 
de sorties à partir d’Edit Pack. L’ensemble 
des méthodes et des instructions détaillées 
sur tous les paramètres de panoramisation 
sont expliquées dans le Chapitre  4, 
Panoramisation avec Edit Pack.
Guide d’Edit Pack



chapitre 3

Notions de base

Ce chapitre présente une vue d’ensemble 
d’Edit Pack et de ses principales sections et 
commandes. 

La Figure  1, page 12, indique l’emplacement 
des principales sections. 
Chapitre 3 : Notions de base 11
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Edit Pack

VU-mètres

Huit VU-mètres haute résolution à 40 segments 
avec DEL et touche CLR METER dédiée. Les 26 
segments inférieurs sont verts, les 13 segments 
médians sont jaunes et la partie supérieure est 
constituée d’un indicateur de clip rouge. 
Incréments d’1 dB : de 0 à -30 ; incréments de 3 
dB : de -33 à -53 et un écart de 7 dB : de -53 à -60.

Affichage du début, de la fin et de la 
durée

Trois afficheurs numériques à 8 segments. Les 
touches correspondantes permettent de 
sélectionner le mode Edit Selection ou Timeline 
Selection, ou de coupler ces deux modes. Pour 
en savoir plus, reportez-vous à Touches Start, 
End et Length, page 13. 

Figure 1.  Principales sections d’Edit Pack

VU-mètres

Début, fin, durée 

Clavier

Trackball

Fonctions

Sections de 
panoramisation

Joysticks
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Sections de panoramisation

Edit Pack comprend deux sections identiques de 
panoramisation, composées d’un joystick, d’un 
bouton rotatif et de plusieurs touches de 
commande. Vous trouverez davantage 
d’informations sur les sections de 
panoramisation dans le Chapitre 4, 
Panoramisation avec Edit Pack.

Clavier et trackball

Edit Pack comprend également un clavier et un 
trackball qui remplacent ou viennent compléter 
le clavier et la souris de votre ordinateur. Le 
clavier est constitué de diverses touches à la 
surface personnalisée et colorée renvoyant à 
certaines fonctions et commandes Pro Tools. 
Celles-ci vous serviront à sélectionner des pistes, 
des sessions et des paramètres, à saisir des 
commentaires ou d’autres entrées de texte et à 
accéder à directement à certaines commandes. 

Sections de touches
Les sections de touches permettent d’accéder 
rapidement et en une seule pression à de 
nombreuses commandes audio et MIDI. Les 
touches renvoient à des commandes dédiées et 
doubles. 

Sections de touches principales Dix-huit 
touches offrent un accès dédié (constant) aux 
commandes dont elles portent le nom. Parmi 
ces touches figurent notamment les touches de 
la section Machine Control, dont START, END 
et LENGTH. Pour plus d'informations, consultez 
Sections de touches principales, page 13. 

Touches d’édition Les sections de touches 
d’édition et TR/F ont une double fonction. Elles 
renvoient à des commandes de session et 
d’édition courantes. Leur fonction est 

déterminée selon le mode dans lequel vous 
travaillez : Main (principal) ou Alt (secondaire). 
Pour plus d'informations, consultez Sections de 
touches d’édition, page 15.

Sections de touches principales

Touches Start, End et Length

La touche EDIT/T LINE détermine le mode de 
saisie des valeurs de temps pour le compteur 
sélectionné. 

◆ Lorsque la touche EDIT/T LINE n’est pas 
allumée, Edit Pack est en mode Edit Selection. 
Dans ce mode, les compteurs et les touches 
Start, End et Length sont activés pour l’affichage 
et l’édition. 

◆ Lorsque la touche EDIT/T LINE est allumée, 
Edit Pack est en mode Timeline Selection. Dans 
ce mode, les compteurs et les touches Start, End 
et Length sont activés pour l’affichage et 
l’édition. 

◆ Lorsque la touche LINK EDIT/T LINE est 
activée (allumée), les modes Edit Selection et 
Timeline Selection sont couplés. Les champs 
restent réglés en fonction du compteur 
sélectionné (selon la touche EDIT/T LINE). 
Lorsque la touche n’est pas allumée, les modes 
Edit Selection et Timeline Selection ne sont pas 
couplés. 

Touches Start, End et Length 
Chapitre 3 : Notions de base 13
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Pour modifier les valeurs des compteurs Edit et 
Timeline :

1 Sélectionnez le mode Edit ou Timeline à l’aide 
de la touche EDIT/T LINE ou LINK EDIT/T LINE. 

2 Appuyez sur START pour accéder au premier 
champ Start dans le compteur sélectionné (Edit 
ou Timeline). 

3 Utilisez le clavier d’Edit Pack ou le clavier 
numérique de ProControl pour entrer des 
valeurs, puis appuyez sur Enter pour confirmer.

4 Répétez cette opération pour les champs End 
et Length. 

Touches utilitaires

Pan Win, Escape, MIDI Event List et Loc Util

PAN WIN Ouvre ou ferme les fenêtres Output 
sélectionnées d’Edit Pack. Pour fermer 
l’ensemble des fenêtres Output, appuyez sur 
OPT(ALT)ALL+PAN WIN. 

MIDI EVENT LIST Ouvre la liste des événements 
MIDI.

ESCAPE Lorsqu’elle clignote, la touche ESCAPE 
permet de quitter les boîtes de dialogue ou 
commandes sélectionnées. Elle équivaut à la 
touche ESCAPE de ProControl et à la touche 
ECHAP du clavier de l’ordinateur.

LOC UTIL Permet d’accéder aux options 
utilitaires d’Edit Pack. Pour en savoir plus sur le 
mode Utility (utilitaire), reportez-vous à 
l’Annexe A, Utilitaires locaux.

Machine Control

La section Machine Control se situe dans la 
partie supérieure de la console Edit Pack, entre 
les sections des touches d’édition et TR/F.

Touches Pan Win, Escape, MIDI Event List et Loc Util

Touches Machine Control

Touches Machine Control et leurs fonctions

Touche Fonction

EXT TRANS Active ou désactive External 
Transport (fenêtre Transport)

AUTO PUNCH Active ou désactive Auto Punch 
(fenêtre Track Arming)

MFI Active ou désactive l’option 
Machine Follows Insertion/Scrub 
(Preferences > Operations)

INSERT 
ASSEM

Active ou désactive l’option Insert 
Assemble (fenêtre Track Arming)

Pour plus d'informations sur ces fonctions, 
consultez le Guide de MachineControl.
Guide d’Edit Pack



Touches Clear Meters et All Notes Off

CLR METERS  Efface tous les indicateurs de clip 
d’Edit Pack, de ProControl et des packs de 
faders, ainsi que les indicateurs de clip à l’écran 
de Pro Tools. L’activation de cette touche 
correspond à l’activation de la touche F1 de 
ProControl et à un clic sur un indicateur de clip 
à l’écran en maintenant enfoncée la touche 
Option. 

ALL NOTES OFF Coupe les notes MIDI coincées 
en envoyant un message à tous les canaux des 
périphériques de la configuration. Cette touche 
correspond à la commande All Notes Off du 
menu MIDI de Pro Tools. 

Touches Track Size Up/Down

TRK SIZE UP et TRK SIZE DOWN Permettent 
respectivement d’augmenter ou de diminuer la 
hauteur de piste dans la fenêtre Edit de la piste 
ou des pistes dans lesquelles se trouve le curseur 
d’édition. 

Touche Auto Suspend

AUTO SUSPEND Interrompt l’ensemble de la 
lecture et de l’enregistrement de l’automation. 
Cette touche correspond à la touche AUTO 
SUSPEND de ProControl et à la commande 
Suspend de la fenêtre Automation Enable de 
Pro Tools. 

Sections de touches d’édition
Edit Pack comprend vingt touches d’édition 
différentes qui renvoient aux nombreuses 
fonctions et commandes de Pro Tools. Les 
quatre sections d’édition et la section TR/F 
permettent d’accéder directement à de 
nombreuses commandes de Pro Tools (qui ne 
sont pas directement disponibles par 
l’intermédiaire du mode Commands Focus). 

Touches Clear Meters et All Notes Off

Touches Track Size Up/Down

Touche Auto Suspend

Sections Tr/F (gauche) et d’édition (droite)
Chapitre 3 : Notions de base 15
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Touches MAIN/ALT et d’édition

Les fonctions de ces touches sont doubles. La 
touche MAIN/ALT, située entre les sections 
Machine Control et Misc, permet de 
sélectionner la commande dont le nom est 
inscrit en bas ou en haut des touches. 

A propos des touches TR/F

Bien qu’il ne s’agisse pas à proprement parler de 
touches d’édition, les touches de la section TR/F 
ont des fonctions doubles, accessibles 
également avec la touche MAIN/ALT. 

Pour sélectionner la fonction d’édition Main 
(supérieure) ou Alt (inférieure) :

■ Appuyez sur la touche MAIN/ALT jusqu’à ce 
qu’elle s’allume (mode Main) ou jusqu’à ce 
qu’elle clignote (mode Alt). 

• En mode Main (touche allumée), les touches 
d’édition permettent d’activer la commande 
dont le nom figure dans la rangée supérieure 
et les touches TR/F fonctionnent en mode TR 
(Track Arming). 

• En mode Alt (touche clignotante), les touches 
d’édition permettent d’appeler la commande 
répertoriée dans la rangée inférieure et les 
touches TR/F fonctionnent en mode F 
(Function).

Touches TR et F
Mode Main, Track Arming Cette touche 
correspond aux commandes de la fenêtre Track 
Arming de Pro Tools et propose des 
caractéristiques d’affichage supplémentaires. 

Mode Alt, F1 à F8 Les touches de fonction 
permettent  de sélectionner un mode 
d’inversion de panoramisation. Consultez 
Couplage inversé, page 28 pour en savoir plus 
sur le couplage et le couplage inversé.

Activation de piste à distance

En mode Main, ces touches correspondent aux 
commandes de la fenêtre Track Arming de 
Pro Tools. Ces touches permettent également de 
visualiser le statut des pistes distantes :

◆ Lorsqu’une piste est activée mais qu’elle n’est 
pas en cours d’enregistrement, la touche TR 
d’Edit Pack correspondante clignote.

◆ Pendant l’enregistrement, la touche cesse de 
clignoter. Elle reste allumée jusqu’à la fin de 
l’enregistrement. 

L’activation de pistes nécessite l’utilisation de 
l’option MachineControl de Digidesign. Pour en 
savoir plus sur l’activation de pistes à distance 
avec Pro Tools, reportez-vous au Guide de 
MachineControl. 

Touches F

En mode Alt, les touches F permettent de 
sélectionner le mode de couplage inversé. Pour 

Touche MAIN/ALT pour fonctions d’édition
Touches de fonction et d’activation de piste
Guide d’Edit Pack



plus d'informations, consultez Couplage des 
sections de panoramisation, page 27. 

Misc et Audio
Mode Main, Misc Bounce to Disk, Shift, 
Duplicate Track, New Track et Auto/Input 
(activation ou désactivation du mode d’écoute)

Mode Alt, Audio Convert and Import Audio, 
Import Other, Import Track, Time Stamp 
Selected et Beat Detective
i

Affichage du mode Input Monitoring

La touche AUTO/INP allumée indique que vous 
êtes en mode Input Only (si elle n’est pas 
allumée, vous êtes en mode Audio Input).

Region-Show/Hide et MIDI-
Edit
Mode Main, Region-Show/Hide Consolidate, 
Heal, Show Only Selected Tracks, Hide Selected 
Tracks et Show All Tracks

Mode Alt, MIDI-Edit Select Note, Split Note, 
Transpose, Merge Paste et Input Quantize

Touches Misc et Audio

Touches MISC et leurs fonctions

Mode Main Fonction

BOUNCE File > Bounce to Disk

SHIFT Edit > Shift

DUP TRK File > Duplicate Track

NEW TRK File > New Tracks

AUTO/INP Sélection de Input ou Input Only

Touches AUDIO et leurs fonctions

Mode Alt Fonction

CONV IMP Regions List > Convert & Import 
Audio

IMP OTHER Movie > Import Other Audio from 
Movie

IMP TRK File > Import Tracks

T STAMP Regions List > Time Stamp Selected

BEAT DET MIDI > Beat Detective

Touches Region-Show/Hide et MIDI-Edit

Touches Region Show/Hide et leurs fonctions

Mode Main Fonction

CONS Edit > Consolidate Selection

HEAL Edit > Heal Separation

SHOW SEL Show Only Selected Tracks

HIDE SEL Hide Selected Tracks

SHOW ALL Show All Tracks

Touches MIDI-EDIT et leurs fonctions

Mode Alt Fonction

SEL NOTE MIDI > Select Note

SPL NOTE MIDI > Split Notes

TRANS MIDI > Transpose

MRG/PSTE Edit > Merge Paste

INP QUANT MIDI > Input Quantize
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Edit et MIDI-Change
Mode Main, Edit Trim, Duplicate, Repeat, Insert 
Silence et Fill with Paste

Mode Alt, MIDI-Change Tempo, Meter, Velocity, 
Duration et Quantize

Auto-Write et Plug-In
Mode Main, Auto-Write Start, All, End, Current et 
All Enabled. 

Mode Alt, Plug-In Copy, Paste, Compare, Save et 
Save As.

Touches Edit et MIDI-Change

Touches Edit et leurs fonctions

Mode Main Fonction

TRIM Edit > Trim

DUPL Edit > Duplicate

REPEAT Edit > Repeat 

INS SILNCE Edit > Insert Silence

F PASTE Edit > Repeat Paste to Fill Selection

Touches MIDI-Change et leurs fonctions

Mode Alt Fonction

TEMPO Change Tempo dialog

METER Change Meter dialog

VEL Change Velocity dialog

DUR Change Duration dialog

QUANT Quantize dialog

Touches Auto Write et Plug-In

Touches Auto-Write et leurs fonctions

Mode Main
Fonction (fenêtre Automation 
Enable)

START Write Automation to Start

END Write Automation to End

ALL Write Automation to All

CURRENT Write Automation to Currently 
Enabled

ALL ENAB Write Automation to All Enabled

Touches Plug-In et leurs fonctions

Mode Alt Fonction (fenêtre Plug-In Target)

COPY Copy Settings

PASTE Paste Settings

COMPARE Compare

SAVE Save Settings

SAVE AS Save Settings As
Guide d’Edit Pack



Auto-Write

Ces touches sont des raccourcis vers diverses 
fonctions d’automation particulièrement utiles, 
comme la fonction d’écriture On Stop sur start, 
end et all.

Start, All, End En mode par défaut (manuel), ces 
touches ont la même fonction que les 
commandes de la fenêtre Automation Enable de 
Pro Tools. 

Current et All Enabled La touche Current 
correspond à la commande Edit > Write 
Automation to Currently Enabled Parameter 
(Commande+/). La touche All Enabled 
correspond quant à elle à la commande Edit > 
Write Automation to All Parameters 
(Ctrl+Commande+).

Auto Write On Stop

Les touches Auto-Write permettent également 
d’activer les commandes Auto Write On Stop 
disponibles. 

Pour activer un mode On Stop :

■ Appuyez sur Ctrl+START, ALL ou END. 

La touche clignote, indiquant qu’un mode On 
Stop est activé. 

Pour annuler un mode On Stop :

■ Appuyez sur la touche clignotante START, ALL 
ou END. 

Auto Suspend

La touche AUTO SUSPEND, située à droite des 
touches Auto-Write, permet d’activer les modes 
Suspend All Automation ou All Automation 
Enabled. Elle correspond à la touche AUTO 
SUSPEND de la surface ProControl et de la 
fenêtre Automation Enable de Pro Tools. 

Pour interrompre l’automation :

■ Lorsque Pro Tools est arrêté, appuyez sur 
AUTO SUSPEND. 

La touche clignote lorsque l’automation est 
interrompue. Pour annuler la fonction Auto 
Suspend, appuyez sur l’une des touches 
clignotantes.
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chapitre 4

Panoramisation avec Edit Pack

Edit Pack présente deux sections de 
panoramisation complètes, avec chacune un 
joystick DigiPanner, un sélecteur rotatif et des 
contrôles commutés.

Activation des sections de panoramisation 
mono et stéréo

Les deux sections de panoramisation peuvent 
être sélectionnées indépendamment l’une de 
l’autre pour la panoramisation d’une piste ou 
d’un départ dans une session. 

Lorsque Edit Pack cible des pistes stéréo, les 
côtés gauche et droit remplacent les 
destinations de panoramique en cours (les deux 
côtés du chemin stéréo sont affectés aux 
sections de panoramisation gauche et droite, 
remplaçant les destinations précédentes). Si, par 
la suite, une section de panoramisation mono 
est ciblée, remplaçant l’un des deux côtés d’une 
destination stéréo, Edit Pack affiche la sortie 
sélectionnée et passe en mode double mono. 

Panoramisation avec Edit Pack et ProControl 

Le ciblage d’Edit Pack s’effectue 
indépendamment des destinations et des 
sélections de canaux Pro Tools (à l’écran) et 
ProControl. Vous pouvez ainsi faire 
correspondre une piste stéréo aux sections de 
panoramisation d’Edit Pack (occupant les deux 
sections de panoramisation) et mapper la sortie 

d’une piste mono sur ProControl (DSP 
Edit/Assign). Si nécessaire, vous pouvez 
également mapper trois canaux par 
l’intermédiaire des deux surfaces de contrôle. 

Affichage chromatique de l’activation 
d’Edit Pack

A l’écran, les destinations ou cibles en cours 
d’Edit Pack sont entourées d’une bordure 
bicolore (orange et violette), chaque couleur 
correspondant à l’une des deux sections. 

La couleur de la destination ProControl dépend 
du nombre d’unités (pour en savoir plus, 
reportez-vous au Guide de référence de 
ProControl).

Plusieurs contrôleurs peuvent avoir 
simultanément la même sortie comme 
destination. Lorsque Edit Pack et ProControl 
(ou une autre surface de contrôle) ciblent la 
même sortie, cette dernière est entourée de 
blanc. 
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Sélection de pistes et de 
départs dans les sections de 
panoramisation
Avec Edit Pack, il est possible d’affecter des 
sorties Pro Tools aux sections de 
panoramisation de différentes manières, 
décrites dans les sections suivantes. Vous 
pouvez notamment :

• utiliser le trackball et les touches de 
modification pour sélectionner, à l’écran, les 
fenêtres Output et les faire correspondre aux 
sections de panoramisation d’Edit Pack

• sélectionner des pistes pour réaliser un 
panoramique de leur sortie principale

• sélectionner les départs ou les sorties 
principales d’une piste

Activation des sections de 
panoramisation à l’écran

Vous pouvez utiliser la souris pour sélectionner 
une fenêtre Output ouverte. 

Pour activer la première section de 
panoramisation (gauche) dans une fenêtre 
Output :

■ Cliquez dans l’en-tête gris d’une fenêtre 
Output ouverte (ne cliquez pas sur une 
commande, seulement sur l’arrière-plan gris 
foncé).  

La sortie est automatiquement affectée au 
premier joystick (gauche). Si la sortie 
sélectionnée est assignée à une piste stéréo, les 
deux sections de panoramisation et les joysticks 
ciblent la sortie. 

Vous pouvez régler des paramètres dans d’autres 
fenêtres Output sans devoir réajuster Edit Pack 
(à condition de ne pas cliquer dans l’en-tête de 
fenêtre). 

Pour activer la seconde section de panoramisation 
(droite) dans une fenêtre Output :

■ Cliquez dans l’en-tête d’une fenêtre Output 
tout en maintenant la touche Commande 
enfoncée. 

Les départs et sorties d’une piste stéréo sont 
automatiquement affectés aux deux sections de 
panoramisation. 

Pour ouvrir et activer une fenêtre Output :

■ Cliquez sur l’icône Output d’une piste mono 
pour l’ouvrir en tant que cible de la section de 
panoramisation 1. S’il s’agit d’une piste stéréo, 
les deux sections de panoramisation sont 
activées. 

■ Cliquez sur l’icône Output d’une piste mono 
tout en maintenant la touche Commande 
enfoncée pour l’ouvrir en tant que cible de la 
section de panoramisation 2. S’il s’agit d’une 
piste stéréo, les deux sections sont activées. 

Zone de clic pour l’activation d’une section de 
panoramisation

cliquez pour activer
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Affichage d’Edit Pack

Dans les fenêtres Mix et Edit, Pro Tools entoure 
les départs ou les pistes principales de la piste 
activées dans Edit Pack de deux couleurs 
différentes (une couleur pour chaque section de 
panoramisation). 

• La cible de la section de panoramisation 1 est 
entourée d’orange.

• La cible de la section de panoramisation 2 est 
entourée de violet.

• Lorsqu’une sortie est la cible de plusieurs 
sections de panoramisation (ou surfaces de 
contrôle), elle est entourée de blanc. 

Sélection de pistes à partir d’Edit Pack

Vous pouvez régler les sections de 
panoramisation sur les départs et les sorties 
principales d’une piste directement à partir 
d’Edit Pack ou à l’aide des touches de 
ProControl. 

◆ Les méthodes ProControl permettent de 
sélectionner des pistes directement à partir des 
voies ou de la matrice de canaux ProControl. 
Ceci est fort pratique lorsque vous travaillez sur 
des sections volumineuses pour lesquelles le 
défilement est trop lent. 

◆ Les commandes des sections de 
panoramisation permettent de faire défiler les 
sorties d’autres pistes. 

Pour sélectionner des pistes :

1 Appuyez sur la touche TRACK SEL (située à 
côté du bouton rotatif SEL/ADJUST). Le mode 
Track Select est alors activé pour la section de 
panoramisation sélectionnée. 

2 Pour sélectionner une piste, effectuez l’une 
des actions suivantes :

• Tournez le bouton rotatif SEL/ADJUST pour 
faire défiler les pistes disponibles. Une fois la 
piste de votre choix affichée, appuyez de 
nouveau sur TRACK SEL pour cibler sa sortie 
principale.

• Sur la surface ProControl, appuyez sur SELECT 
dans le contrôle des voies correct pour cibler 
la sortie principale de la piste correspondante.

• Sur la surface ProControl, utilisez la matrice 
de canaux pour cibler la sortie principale de la 
piste correspondante. 

Une fois sélectionnée, la sortie principale de la 
piste sélectionnée est affectée à la section de 
panoramisation. 

Outils et affichages de navigation

Touche PAGE et commandes de navigation dans les 
sections de panoramisation

TRACK SEL

SEL/ADJUST

PAGE

MAIN / SEND

TRACK SEL
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Sélection des sorties d’une piste à 
partir d’Edit Pack

Il est possible d’affecter une ou plusieurs sorties 
de piste principales, et jusqu’à cinq départs à 
chaque piste Pro Tools. Il est également possible 
d’affecter plusieurs sorties à chaque départ. 
Après la sélection d’une piste, Edit Pack active la 
sortie possédant le plus grand nombre de 
canaux de sortie (dans le cas où plusieurs sorties 
ont été affectées à la piste). Si, par exemple, une 
piste (ou un départ) est affectée à un chemin 
stéréo et une sortie 5.1, la sortie 5.1 devient la 
sortie principale de la fenêtre Output pour cette 
piste. Elle est alors activée dans Edit Pack.

Pour sélectionner la sortie principale de la piste 
sélectionnée :

1 Sélectionnez la piste sur laquelle vous 
souhaitez effectuer un panoramique en suivant 
les techniques décrites dans Sélection de pistes à 
partir d’Edit Pack, page 23. 

2 Appuyez sur MAIN pour activer la sortie 
principale de la piste, le cas échéant. 

Pour activer l’affectation de la sortie principale 
d’une autre piste :

■ Appuyez sur MAIN + la flèche gauche ou 
droite pour faire défiler les autres pistes de la 
session. 

Les fenêtres Output sélectionnées ne s’ouvrent 
que lorsque la touche MAIN ou SEND est 
relâchée. Les fenêtres sélectionnées s’affichent 
selon les principes suivants :

◆ Lorsque vous faites défiler les pistes dans la 
section de panoramisation 1, la fenêtre Output 
sélectionnée s’ouvre ou reste fermée, selon l’état 
de la touche PAN WIN (lorsque la touche PAN 
WIN est allumée, les fenêtres Output s’ouvrent ; 
dans le cas contraire, elles restent fermées). 

◆ Lorsque vous faites défiler les pistes dans la 
section de panoramisation 2, la fenêtre Output 
sélectionnée s’ouvre automatiquement, sa 
destination étant désactivée. 

Sélection de départs à partir 
d’Edit Pack

Vous pouvez sélectionner différents départs 
pour leur panoramisation à partir d’Edit Pack en 
procédant comme suit : 

Pour sélectionner le départ A dans la piste 
activée :

■ Appuyez sur SEND pour activer le dernier 
départ ciblé dans une section de 
panoramisation. Si aucun départ n’est affecté à 
la piste sélectionnée, Edit Pack signale l’absence 
de départ par un message.

Pour faire défiler les départs :

■ Appuyez sur MAIN + flèche haut ou bas pour 
faire défiler les départs disponibles de la piste 
sélectionnée.

Pour plus d'informations sur Pro Tools et 
les affectations de sorties multiples, 
consultez le Guide de référence Pro Tools.

Pour de plus amples informations sur la 
destination, reportez-vous au Guide de 
référence Pro Tools.
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Activation à l’aide des touches MAIN et 
SEND

Pour faire défiler les sorties et départs d’autres 
pistes avec Edit Pack, utilisez les touches MAIN 
et SEND en combinaison avec les touches 
fléchées du clavier. 

Pour faire défiler tous les départs de la session :

■ Appuyez sur MAIN + la touche fléchée gauche 
ou droite pour faire défiler toutes les pistes (y 
compris celles auxquelles aucun départ ou sortie 
n’est affecté). 

Pour faire défiler tous les départs de la session :

■ Appuyez sur SEND + la touche fléchée gauche 
ou droite pour faire défiler les départs d’autres 
pistes. 

Ouverture et fermeture des fenêtres 
Output

Lorsque vous activez une sortie à partir 
d’Edit Pack, la fenêtre Output correspondante 
s’affiche automatiquement. Vous pouvez fermer 
et ouvrir la fenêtre de destination d’Edit Pack en 
cours, tout en conservant l’activation de la 
sortie dans la section de panoramisation, à l’aide 
de la touche PAN WIN. 

Pour fermer (ou ouvrir) la fenêtre Output en cours :

■ Appuyez sur PAN WIN.

Pour refermer toutes les fenêtres Output :

■ Appuyez sur Option + PAN WIN.

La touche PAN WIN indique également le statut 
des fenêtres en cours (ouvertes ou fermées). Pour 
en savoir plus, reportez-vous à Fenêtre Pan, 
page 29.

Panoramisation
Edit Pack permet d’accéder à l’ensemble des 
commandes de panoramisation de Pro Tools, y 
compris la sélection de mode, la panoramisation 
par bouton ou joystick, ainsi que les paramètres 
de divergence, de pourcentage de centrage et de 
LFE. 

Joysticks

Les joysticks DigiPanner motorisés et tactiles 
permettent d’effectuer des panoramiques de 
360° sur l’audio de Pro Tools. 

Pour effectuer un panoramique à l’aide des 
joysticks :

1 Sélectionnez la sortie principale ou le départ 
d’une piste à l’aide des méthodes décrites dans 
Sélection de pistes et de départs dans les sections 
de panoramisation, page 22.

2 Effectuez un panoramique à l’aide du 
joystick. Utilisez le bouton tactile de prise de 
contrôle. Le panoramique adopte les réglages de 
la correspondance automatique et du délai 
d’inertie tactile. 

Sections de panoramisation
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Pour effectuer un panoramique à l’aide des 
boutons :

1 Sélectionnez un canal ou un départ en 
suivant les méthodes décrites dans Sélection de 
pistes et de départs dans les sections de 
panoramisation, page 22. 

2 Sélectionnez un paramètre de 
panoramisation en appuyant sur la touche 
correspondante (FRONT, REAR ou F/R 
(Front/Rear)).

3 Tournez le bouton SEL/ADJUST pour régler le 
paramètre de panoramisation sélectionné. 

Modes de panoramisation et joystick

Pro  Tools présente les modes panoramiques 
X/Y et à trois boutons pour la panoramisation 
surround. Ces modes, décrits dans le Guide de 
référence Pro Tools, proposent deux méthodes 
différentes pour la panoramisation surround. 

Vous pouvez passer du mode X/Y au mode 3-
Knob (à trois boutons) à tout moment. 

Pour choisir un mode de panoramisation :

1 Appuyez sur la touche PAGE jusqu’à ce qu’elle 
soit allumée et que le mode Page 2 soit indiqué. 

2 Appuyez sur C% (Mode).

3 Tournez le bouton SEL/ADJUST pour 
sélectionner un mode (X/Y, divergence ou à 
trois boutons). 

Panoramisation en mode à trois boutons avec le 
joystick

Lorsque le mode de panoramisation à trois 
boutons est activé, Pro Tools filtre les 
mouvements du joystick situés en dehors de la 
trajectoire du panoramique. Les joysticks 
DigiPanner ne restreignent pas la trajectoire 
pendant l’écriture de données. Pendant la 
lecture, ils suivent la trajectoire automatisée. 

Divergence, centrage et LFE

Les touches des paramètres de panoramisation 
permettent de régler le bouton rotatif 
SEL/ADJUST. La touche PAGE permet de 
sélectionner la fonction inférieure ou supérieure 
des touches des paramètres de panoramisation.

Pour sélectionner des paramètres de 
panoramisation supérieurs ou inférieurs (page 1 
ou page 2) :

■ Appuyez sur PAGE. La touche PAGE n’est pas 
allumée lorsque le paramètre supérieur (page 1) 
est sélectionné. Elle est allumée lorsque le 
paramètre inférieur (page 2) est sélectionné. 

Pour régler la divergence :

1 Sélectionnez une sortie ou un départ en 
suivant les méthodes décrites dans Sélection de 
pistes et de départs dans les sections de 
panoramisation, page 22. 

2 Appuyez sur la touche PAGE jusqu’à ce qu’elle 
soit allumée et que le mode Page 2 soit activé. 

3 Sélectionnez un paramètre de 
panoramisation en appuyant sur la touche 
correspondante (F DIV, R DIV ou F/R DIV).

4 Tournez le bouton SEL/ADJUST. 

Paramètres de panoramisation et bouton SEL/ADJ

SEL/ADJUST
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Pour régler Center% :

1 Sélectionnez une sortie ou un départ en 
suivant les méthodes décrites dans Sélection de 
pistes et de départs dans les sections de 
panoramisation, page 22. 

2 Appuyez sur la touche PAGE jusqu’à ce qu’elle 
soit allumée et que le mode Page 2 soit activé.

3 Appuyez sur C%. 

4 Tournez le bouton SEL/ADJUST. 

Pour régler le niveau de LFE :

1 Sélectionnez une sortie ou un départ en 
suivant les méthodes décrites dans Sélection de 
pistes et de départs dans les sections de 
panoramisation, page 22. 

2 Assurez-vous d’être en mode Page 1 (la touche 
PAGE ne doit pas être allumée).

3 Appuyez sur LFE. 

4 Tournez le bouton SEL/ADJUST.

Couplage des sections de 
panoramisation
La touche LINK PANNERS permet d’activer le 
couplage et le couplage inversé des sections de 
panoramisation. Lorsque ces modes sont 
activés, Edit Pack copie les mouvements d’un 
joystick vers l’autre joystick. En mode de 
couplage, les données d’automation sont écrites 
vers le joystick utilisé, ainsi que sur le joystick 
non utilisé (couplé). Vous pouvez activer ou 
désactiver le mode de couplage à tout moment. 

Avec Pro Tools, vous pouvez coupler les deux 
côtés d’une piste stéréo pour une 
panoramisation en couplage ou couplage 
inversé. Avec Edit Pack, vous pouvez également 
effectuer un couplage ou un couplage inversé de 
deux pistes mono. Dans le cas de pistes mono 

couplées dans les sections de panoramisation 
Edit Pack, l’utilisation des deux joysticks 
temporairement couplés inverse le mode de 
couplage. Dès que vous relâchez l’un des 
joysticks, il adopte les coordonnées du joystick 
utilisé. 

Couplage absolu

Lorsqu’elles sont couplées, les données 
d’automation identiques sont transmises d’une 
section de panoramisation à l’autre (on parle de 
couplage absolu). 

Couplage et couplage inversé des 
panoramiques de pistes mono 

Pro Tools permet le couplage des sections de 
panoramisation uniquement dans les fenêtres 
Output stéréo. Avec Edit Pack, vous pouvez 
cependant activer deux sorties mono discrètes et 
les coupler à partir de la section de 
panoramisation. 

Pistes stéréo

Utilisez les icônes de couplage de chaque fenêtre 
Output pour contrôler à l’écran le couplage de 
pistes stéréo et le couplage inversé.

Pour coupler les sections de panoramisation :

1 Ciblez les sections de panoramisation en 
suivant la procédure décrite dans Sélection de 
pistes et de départs dans les sections de 
panoramisation, page 22. 

2 Appuyez sur LINK PANNERS.

Commandes de couplage dans les fenêtres Output

Couplage 

Inversion avant/arrière

Inversion avant

Inversion arrière
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Couplage inversé

Edit Pack prend en charge le couplage inversé de 
Pro Tools, avec lequel les déplacements de 
panoramique sur pistes stéréo sont inversés 
entre les deux sections de panoramisation. Avec 
Edit Pack, il est également possible de coupler 
deux pistes mono. Dans le cas de pistes mono, 
les joysticks prennent en charge les modes de 
couplage et de couplage inversé (ceux-ci ne sont 
pas pris en charge par le bouton rotatif 
SEL/ADJUST pour le couplage de deux pistes 
mono, SEL/ADJUST prenant uniquement en 
charge le couplage des côtés d’une piste stéréo).

Lorsque LINK PANNERS est activé, les trois 
modes inversés sont disponibles : Front, Rear et 
Front/Rear. Les modes inversés peuvent être 
utilisés séparément ou conjointement. 

Inversion avant

Disponible pour tous les formats de pistes 
(mono, stéréo et multicanaux). 

Pour activer le couplage avant inversé :

1 Appuyez sur MAIN/ALT pour activer le mode 
Alt.

2 Appuyez sur F1.

Inversion arrière

Disponible uniquement pour les formats 
multicanaux avec au moins deux canaux arrière 
discrets. 

Pour activer le couplage arrière inversé :

1 Appuyez sur MAIN/ALT pour activer le mode 
Alt.

2 Appuyez sur F2.

Inversion avant/arrière

Disponible uniquement pour les formats 
multicanaux avec canaux surround (arrière). 

Pour activer le couplage avant/arrière inversé :

1 Appuyez sur MAIN/ALT pour activer le mode 
Alt.

2 Appuyez sur F3.

Outils et affichages de navigation

Bouton Link Panners
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Track Fader, Solo, Mute et 
Automation 
Edit Pack permet de contrôler le volume des 
canaux, ainsi que les modes Solo, Mute et 
Automation à partir de chaque section de 
panoramisation. 

Pour mettre la piste en cours en mode Solo :

■ Appuyez sur SOLO dans la section de 
panoramisation correspondante. 

Pour mettre la piste en cours en mode Mute :

■ Appuyez sur MUTE dans la section de 
panoramisation correspondante.

Pour régler le niveau de la piste ou du départ :

1 Appuyez sur MAIN/ALT pour activer le mode 
Alt.

2 Appuyez sur LFE/VOL.

3 Tournez le bouton SEL/ADJUST. 

Pour modifier le mode d’automation de piste :

■ Utilisez la touche AUTO pour sélectionner un 
mode d’automation pour le canal ciblé. 

Fenêtre Pan
La touche PAN WIN et son afficheur DEL 
permettent d’ouvrir et de fermer les fenêtres 
Output. Elles indiquent également le statut des 
fenêtres (ouvertes ou fermées) :

Touche PAN WIN allumée Indique qu’au moins 
une fenêtre Output activée par Edit Pack est 
ouverte à l’écran. Si vous activez une nouvelle 
sortie, la fenêtre Output correspondante 
s’ouvre. Appuyez sur la touche PAN WIN 
lorsqu’elle n’est pas allumée pour refermer les 
fenêtres Output activées par Edit Pack (la sortie 
reste toutefois activée dans Edit Pack).

Touche PAN WIN éteinte Indique qu’aucune 
fenêtre Output activée par Edit Pack n’est 
ouverte à l’écran. Si vous activez une nouvelle 
sortie, la fenêtre Output correspondante ne 
s’ouvre pas. Appuyez sur la touche PAN WIN 
lorsqu’elle n’est pas allumée pour ouvrir la sortie 
activée (le cas échéant).

Pour refermer toutes les fenêtres Output 
ouvertes :

■ Appuyez sur Option+PAN WIN.

Vous pouvez configurer l’automation de 
piste à partir d’Edit Pack, de ProControl ou 
à l’écran. La touche AUTO d’Edit Pack 
permet de quitter rapidement le mode 
d’automation.
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annexe a

Utilitaires locaux

La fonction Utilities d’Edit Pack  permet de 
régler la sensibilité des joysticks (réponse), le 
contraste de l’affichage et le mode de veille, 
ainsi que de tester les DEL, les VU-mètres et 
d’autres fonctions. 

Utilitaires et tests

Pour activer le mode Utilities :

1 Appuyez sur LOC UTIL. La DEL des sections 
de panoramisation affiche les choix d’utilitaires. 

2 Sélectionnez une option en appuyant sur la 
touche MAIN clignotante, sous chaque 
sélection. Pour afficher d’autres options 
d’utilitaires, appuyez sur PAGE.

Pour vérifier les ports Com et FDR :

1 Appuyez sur LOC UTIL. 

2 Appuyez sur la touche MAIN clignotante sous 
l’option SYSTEM affichée dans la section de 
panoramisation 1. Les versions système restent 
affichées jusqu’à ce que vous relâchiez la touche 
MAIN.

Pour saisir un nom personnalisé pour Edit Pack :

1 Appuyez sur LOC UTIL pour activer le mode 
Utilities.

2 Appuyez sur MAIN pour sélectionner NAME 
(section de panoramisation 2). Le nom de 
l’unité sélectionnée (EDITPACK par défaut) est 
affiché dans la section de panoramisation 2. Le 
premier caractère clignote, indiquant qu’il est la 
cible de l’édition.

3 Sélectionnez des caractères à l’aide du bouton 
SELECT/ADJ de la section de panoramisation 1. 
Pour déplacer le curseur (lettre clignotante), 
tournez le bouton SELECT/ADJ de la section de 
panoramisation 2. 

Utilitaires de test

Edit Pack intègre des fonctions de test pour les 
DEL, les touches et les joysticks. 

Pour exécuter les auto-tests d’Edit Pack :

1 Appuyez sur LOC UTIL pour activer le mode 
Utilities.

2 Appuyez sur PAGE jusqu’à ce que la page 2/2 
s’affiche. La section de panoramisation 1 affiche 
TEST. 

3 Sélectionnez TEST en appuyant sur la touche 
MAIN dans la section de panoramisation 1. Les 
tests disponibles sont affichés sur différentes 
pages du test utilitaire de DEL. 
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• Pour tester les DEL, affichez Test Page 1/3, puis 
sélectionnez une DEL en appuyant sur la 
touche MAIN clignotante située en dessous 
dans la section de panoramisation 1. Appuyez 
sur PAGE pour sélectionner un test de DEL 
spécifique (Vegas, Switch test, Red, Yellow, 
Green ou All). 

• Pour tester les VU-mètres ou l’affichage des 
codes temporels d’Edit Pack, appuyez sur LOC 
UTIL+PAGE, puis sur la touche MAIN 
appropriée pour sélectionner TEST. Appuyez 
sur DISPLAY, puis sélectionnez un test 
d’affichage à l’aide de la touche MAIN 
appropriée. 

• Pour tester les joysticks, appuyez sur LOC 
UTIL+PAGE+TEST, puis sur PAGE jusqu’à ce 
que JOYSTICK s’affiche dans la section de 
panoramisation 1. Appuyez sur la touche 
MAIN clignotante, puis sélectionnez un test 
de joystick. Le bouton SELECT/ADJ permet de 
contrôler la vitesse du test. 

• Pour tester les boutons rotatifs, appuyez sur 
LOC UTIL+PAGE+TEST, puis sur PAGE jusqu’à 
ce que ROTARIES s’affiche dans la section de 
panoramisation 2. Appuyez sur la touche 
MAIN clignotante dans la section de 
panoramisation 2, puis réglez l’un des 
boutons rotatifs Edit Pack. Les résultats sont 
affichés dans les sections de panoramisation.

Pour restaurer les paramètres par défaut 
d’Edit Pack :

■ Appuyez sur LOC UTIL+PAGE pour afficher la 
page 2/2, puis sélectionnez RESET. Suivez les 
instructions affichées dans la section de 
panoramisation.

Préférences d’Edit Pack

Vous pouvez personnaliser les préférences 
d’Edit Pack. Différents paramètres sont 
disponibles pour le contraste des DEL, le mode 
veille et la réponse des joysticks. 

Pour régler les préférences d’Edit Pack :

1 Appuyez sur LOC UTIL+PAGE pour afficher la 
page 3/3 et PREFS.

2 Appuyez sur la touche MAIN clignotante pour 
sélectionner l’option PREFS.

• Pour régler le contraste (la luminosité) de la 
DEL, appuyez sur MAIN pour sélectionner 
CONTRASTE et tournez le bouton 
SELECT/ADJ sur la section de panoramisation 
1 pour augmenter ou réduire le contraste des 
DEL d’Edit Pack.

• Pour configurer le mode de veille d’Edit Pack, 
appuyez sur MAIN dans la section de 
panoramisation 1 pour sélectionner SLEEP, 
puis tournez le bouton SELECT/ADJ (section 
de panoramisation 2) pour sélectionner une 
durée de veille (de une à douze heures).

• Pour régler la réponse du joystick, appuyez sur 
PAGE pour afficher Prefs page 2/2, JOYSTICK. 
Appuyez sur la touche MAIN clignotante pour 
sélectionner JOYSTICK. Tournez ensuite l’un 
des boutons SELECT/ADJ pour augmenter ou 
réduire la tension du joystick. 
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Dimensions d’Edit Pack 

Largeur, longueur et hauteur de la surface 
Edit Pack

38,4 cm x 63,6 cm x 18 cm

Ces dimensions sont identiques à celles des 
modules d’extension (packs de faders) (le châssis 
d’Edit Pack est de taille semblable). Si vous 
souhaitez concevoir ou construire un meuble 
personnalisé pour votre système ProControl et 
Edit Pack, vous pouvez télécharger des plans à 
l’échelle à partir du site Web de Digidesign. 

Des plans détaillés à l’échelle sont 
disponibles sur le site Web de Digidesign. 
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Nombres
10Base-T 6

A
ADB, connexions 6
Alimentation CA 7
ALL ENAB 18
ALL NOTES OFF 15
AUDIO 17
Auto 29
Auto Input/Input Only 17
Auto Punch 14
Auto Suspend 15, 19
Automation

On Stop 19
write to start, end, all 18

AUTO-WRITE 18

B
Beat Detective 17
Bounce to Disk 17

C
C % (pourcentage de centrage) 27
Change Duration 18
Change Meter 18
Change Tempo 18
Change Velocity 18
Clavier

connexions 5
utilisation 13

CLR METERS 15
Compare 18
Compteurs

Edit et Timeline (couplage) 13
Edit ou Timeline (sélection) 13

configuration de Pro Tools pour Edit Pack 8
Configuration système requise 2
Consignes de sécurité 4
Consolidate Selection 17
Contraste 31, 32
Convert & Import Audio 17
Copy Settings 18
Couplage 27

modes de couplage absolu et inversé 27
pistes mono 27

Couplage des Sections de Panoramisation 27
CURRENT 18

D
Début, fin et durée

affichages 12
DEL 32
Démarrage du système 8
Départs, sélection pour la panoramisation 24
Dimensions (l x L x h) 33
Divergence 26
Duplicate 18
Duplicate Track 17

E
EDIT 18
EDIT/T LINE 13
ESCAPE 14
Ethernet, connexions 6
External Transport 14

F
Faders 29
Fenêtres et PAN WIN 14, 29
Index 35
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H
Heal Separation 17
Hide Selected Tracks 17

I
Import Other Audio from Movie 17
Import Tracks 17
Input Quantize 17
Insert Assemble 14
Insert Silence 18
Installation logicielle 7
Instructions d’installation 5
Instructions de maintenance 5
Inversion

arrière 28
avant 28
avant/arrière 28

J
Joysticks

modes de panoramisation 26
réglage de la réponse 32

L
LFE 27
Liaison montante 7
LINK EDIT/T LINE 13
Liste des événements MIDI 14
LOC UTIL 14

M
Machine Control 14
Machine Follows Insertion/Scrub 14
MAIN/ALT 16
Merge Paste 17
MIDI-CHANGE 18
MIDI-EDIT 17
MISC 17
Mode de veille 32
Mode Monitor, sélection 17
Modes d’inversion de panoramisation 16
Modes de panoramisation 26
Mute 29

N
New Tracks 17

O
On Stop

annulation 19
automation 19

P
PAN WIN 14
Panoramisation 21

alternance entre pistes et départs 22
couplage 27
pistes stéréo 27
sélection de départs 24
sélection de pistes 23
utilisation des joysticks 25

Paramètres de panoramisation 26
Paste Settings 18
Périphériques 8
Pistes stéréo 27
PLUG-IN 18
Préférences

contraste 32
réponse du joystick 32
veille 32

Q
Quantize 18

R
REGION-SHOW HIDE 17
Repeat 18
Repeat Paste to Fill Selection 18
réponse 31

S
Save Settings 18
Save Settings As 18
Section d’édition 15
SEL/ADJUST 23
Select Note 17
Shift 17
Show All Tracks 17
Show Only Selected Tracks 17
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Solo 29
Split Notes 17
Start, End et Length

touches 13

T
Test 32

Utilitaires pour les tests de composants 31
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